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Nội dung của trang này thuộc bản quyền của © Bá tước Monte Cristo - Final Fantasy và www.vietphotoshop.com. Những bài viết 

trong này có thể được in ra để dùng với mục đích cá nhân và phi thương mại. Nếu bạn muốn phát hành lại trong trang web của bạn làm 

ơn liên lạc với tôi hoặc ít nhất phải trích dẫn lại nguồn là: Bá tước Monte Cristo - Final Fantasy và www.vietphotoshop.com 

 

Công cụ Pen dùng để vẽ những đường thẳng hoặc những đường cong gọi là Path. Bạn có thể sử dụng 

côgn cụ Pen như là một công cụ tô vẽ hoặc nhu một công cụ lựa chọn. Khi được sử dụng như là công 

cụ lựa chọn, công cụ Pen luôn luôn tạo được một đường mềm mại, Anti-alias. Những đường tạo ra bởi 

Pen là một sự lựa chọn tuyệt vời để sử dụng những công cụ lựa chọn chuẩn cho việc tạo ra những 

vùng lựa chọn phức tạp. 

Trong bài này bạn sẽ học được những điều sau: 

• Thực hành vẽ một đường thẳng và cong sử dụng công cụ Pen 

• Lưu lại Path 

• Tô với lệnh Stroke Path 

• Chỉnh sửa Path bằng công cụ Path Editing 

• Biến đổi Path thành vùng lựa chọn 

• Biến đổi vùng lựa chọn thành Path 

Bắt đầu: 

Bạn sẽ bắt đầu bài học bằng việc xem một bản sao của một bức hình hoàn thiện mà bạn sẽ tạo. Sau 

đó bạn sẽ mở một loạt các file có những hướng dẫn giúp bạn đi qua quá trình tạo một đường thẳng, 

đường cong và đường kết hợp của hai đường trên. Hơn nữa, bạn sẽ học cách thêm một điểm vào 

Path, bớt điểm đi ở Path và biến một đường thẳng thành đường cong và ngược lại. Sau khi bạn thực 

hành xong với việc vẽ và chỉnh sửa Path sử dụng các Template, bạn sẽ mở một tấp hình đồ chơi con 

tàu vũ trụ và thực tập thêm với việc tạo vùng lựa chọn bằng công cụ Pen.  
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1. Trên thành tuỳ biến công cụ, chọn nút File Browser.  

2. Trong FIle Browser Palette, tìm đến thư mực Lesson9 và chọn file 09End.psd trong cửa sổ biểu 

tượng thu nhỏ để hình đó xuất hiện bên cửa sổ xem trước. File 09End.psd là kết quả cuối cùng của 

hình chiếc đĩa bay. Nếu bạn đã có kinh nghiệm về vẽ vector bạn có thể lướt qua đoạn đầu của bài học 

này để biết về công cụ và tuỳ biến của nó trong Photoshop khi bạn bắt đầu làm việc với bài tập về đĩa 

bay này.  

3. Nhấp đúp vào hình biểu tượng thu nhỏ của file Straight.psd để mở nó ra trong Photoshop. 

4. Nếu cần, chọn công cụ Zoom nhấp hoặc kéo qua tấm hình để phóng lớn nó 

Đôi điều về Path và công cụ Pen 

Công cụ Pen vẽ một đường thẳng và cong được gọi là Path. Path là dạng đường nét hoặc hình dạng 

mà bạn vẽ ra nó bằng công cụ Pen, Magnetic Pen hoặc FreeForm Pen. Trong những công cụ này, 

công cụ Pen vẽ đường thẳng chính xác nhất, công cụ Magnetic Pen và Freeform dùng để vẽ những 

đường gần giống như bạn vẽ nháp bằng cây bút chì trên giấy vậy. 

Nhấn chữ P trên bàn phím để chọn công cụ Pen. Nhấn Shift+p để thay đổi lần lượt giữa công cụ 

Pen, Freeform.  

 

Trong bài này bạn chỉ học cách sử dụng Pen. Path có thể được đóng hoặc mở. Một Path mở là nó có 

hai điểm bắt đầu và kết thúc không trùng nhau. Path đóng là điểm bắt đầu và kết thúc gặp nhau tại một 

điểm. Ví dụ vòng tròn là Path đóng. Những loại Path mà bạn vẽ tác động đến nó sẽ được chọn và điều 

chỉnh như thế nào. 

Những Path mà chưa được tô hoặc Stroke sẽ không được in ra khi bạn in hình ảnh của mình. Bởi vì 

Path là dạng đối tượng Vector và nó không chứa những Px, nó không giống như những hình bitmap 

được vẽ bởi Pencil và những công cụ vẽ khác. Trước khi bắt đầu, bạn nên tìm hiểu những tuỳ biến của 

công cụ Pen và môi trường làm việc của bạn để chuẩn bị cho bài học này. 
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1. Trong hộp công cụ chọn công cụ Pen ( ) 

2. Trên thanh tuỳ biến công cụ, chọn hoặc thiết lập những thông số sau: 

 

A. Paths option B. Geometry Options menu C. Add to Path Area option 

3. Nhấp vào Path Palette để mở rộng palette đó ra ngoài nhóm layer palette. Path palette hiển thị hình 

xem trước của path mà bạn vẽ. Hiện tại Palette đang không có gì bởi vì bạn chưa bắt đầu. 

Vẽ một đường thẳng 

Đường thẳng được tạo ra bằng cách nhấp chuột. Lần đầu tiên bạn nhấp chuột, bạn sẽ đặt điểm bắt 

đầu cho Path. Mỗi lần nhấp chuột tiếp theo, một đường thẳng sẽ xuất hiện giữa điểm trước đó và điểm 

vừa nhấp chuột. 

1. Sử dụng công cụ Pen, đặt con trỏ vào điểm A trong template và nhấp chuột. Sau đó nhấp vào điểm 

B để tạo một đường thẳng. Khi bạn vẽ path, một vùng lưu trữ tạm thời có tên là Work Path xuất hiện 

trong Path Palette để đi theo từng nét vẽ của bạn. 

 

2. Kết thúc Path bằng cách nhấp vào công cụ Pen ( ) trong hộp công cụ. Những điểm nối Path lại với 

nhau gọi là Anchor Point. Bạn có thể kéo những điểm riêng lẻ để sửa chữa từng phần của Path, hoặc 

bạn có thể chọn tất cả những điểm Anchor để chọn cả path. 
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3. Trong Path Palette, nhấp đúp vào Work Path để mở hộp thoại Save Path. Đặt tên cho nó là Straight 

Lines và nhấn OK để đặt tên cho Path. Path vẫn được chọn trong path palette. 

 

Bạn nên tạo cho mình thói quen lưu lại Work Path nếu bạn sử dụng nhiều path khác nhau trên cùng 

một tài liệu. Nếu bạn bỏ chọn một Work Path đã có trong Path Palette và tiếp tục một path mới, một 

Work Path mới sẽ thay thế cái cũ, và tất nhiên là cái cũ sẽ bị mất. Tuy nhiên nếu bạn bỏ chọn Work 

Path trong Path Palette, thì Work Path và những gì bạn đang vẽ vẫn ở đó trong khi bạn làm những việc 

khác mà không phải là vẽ Path. Bạn cũng có thể chọn lại Work Path và tiếp tục thêm vào những gì 

đang vẽ. 

Đôi điều cần biết về Anchor Point, đường định hướng, điểm định hướng và những thành tố 
khác: 

Path bao gồm một hoặc nhiều đường thẳng và cong. Anchor Point đánh dấu những điểm kết thúc của 

Path. Ở vùng path cong, mỗi một điểm Anchor point được chọn hỉên thịn một hoặc hai đường định 

hướng, kết thúc ở điểm định hướng. Vị trí của đường định hướng và Point xác định kích thước và hình 

dạng của những vùng Path cong. Di chuyển những thành phần này sẽ định dạng lại những đường cong 

của Path. Một path có thể là path đóng mà không có cả điểm đầu và kết thúc ví dụ như hình tròn, hoặc 

là Path mở với điểm đầu và điểm kết thúc không trùng nhau ví dụ là đường gợn sóng. 

Một đường cong mềm mại được nối với nhau bởi những điểm Anchor Point và gọi là những Smooth 

Point. Những đường cong sắc nhọn được nối với nhau bởi những Corner Point. Khi bạn di chuyển 

đường định hướng trên một Smooth Point, vùng cong ở hai bên của điểm đó tự đồng điều chỉnh đồng 

thời. Ngược lại, khi bạn di chuyển đường định hướng trên một Corner Point, chỉ duy nhất vùng con ở 

trên cùng một bên của điểm tại đúng vị trí đường định hướng được điều chỉnh.  

Một path không nhất thiết phải là một loạt những phần nhỏ nối tiếp với nhau. Nó có thể bao gồm nhiều 

hơn một những thành phần Path riêng lẻ. Mỗi hình dạng trong Shape Layer là một thành phần của 

path, được miêu tả là Clipping Path của layer. 
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Di chuyển và điều chỉnh Path 

Bạn sử dụng công cụ Direct Selection để chọn và điều chỉnh những điểm neo (anchor point) ở trên một 

phần của path hoặc cả path. 

1. Chọn công cụ Direction Select ( ) được ẩn dưới công cụ Path Select ( ) trong hộp công cụ.  

Để chọn công cụ Direct Selection bằng lệnh gõ tắt nhấn phím A. Hơn nữa, khi công cụ Pen đang 

được chọn bạn có thể tạm thời chuyển qua công cụ Direct Selection bằng cách giữ phím Ctrl. 

2. Nhấp vào điểm A-B để chọn nó trong cửa sổ, và sau đó di chuyển Path bằng cách kéo nó đi loăng 

quăng với công cụ Direction Selection. 

 

3. Để điều chỉnh độ dốc hoặc chiều dài của Path, kéo một điểm neo với công cụ Direct Selection. 

 

4. Chọn công cụ Pen ( ) 

5. để tiếp tục với Path kế tiếp, giữ con trỏ qua điểm C để cho một chữ x xuất hiện trên con trỏ của công 

cụ Pen chỉ ra rằng nếu bạn nhấp chuột sẽ bắt đầu một path mới, và sau đó nhấp vào điểm C. 
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6. Nhấp vào điểm D để vẽ Path giưa hai điểm. 

 

7. Đóng Path lại sử dụng những phương pháp sau: 

- Nhấp vào công cụ Pen trong hộp công cụ 

- Giữ phím Ctrl để tam thời chuyển sang công cụ Direct Selection và nhấp ra ngoài Path. 

Vẽ một đường thẳng với nhiều phần khác nhau 

Cho đến lúc này bạn đã thực hành với path có 2 điểm. Bạn có thể vẽ một đường thẳng phức tạp hơn 

bằng công cụ Pen chỉ đơn giản bằng cách thêm điểm vào. Những đoạn và những điểm neo này có thể 

được loại bỏ sau này, bạn có thể loại từng em một hoặc chơi một phát cả lũ hy sinh. 

1. Sử dụng công cụ Pen ( ) nhấp vào điểm E để bắt đầu một path tiếp theo. Sau đó giữ phím Shift và 

nhấp vào điểm F, G, H và I. Giữ phím shift sẽ giúp bạn tạo một đường xiên một góc 45 độ. 

 

Chú ý: Nếu bạn vẽ sai gì đó, chọn Edit > Undo để thử lại hoặc bạn có thể dùng History Palette. 

2. Để đóng path lại sử dụng những phương phá bạn đã học. Khi một path chưa nhiều hơn một phân 

đoạn, bạn có thể kéo từng điểm neo riêng lẻ để điều chỉnh những phân đoạn riêng lẻ của path. Bạn 

cũng có thể chọn tất cả những điểm neo trên Path để chỉnh sửa cùng một lúc. 
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3. Chọn Direct Selection ( ) 

4. Nhấp vào phân đoạn zic zac và kéo để di chuyển toàn bộ các phân đoạn khác. Khi bạn kéo, cả hai 

điểm neo của phân đoạn đó đều di chuyển theo và những phân đoạn nói với nhau cũng tự điều chỉnh 

theo. Độ dài và độ dốc của những phân đoạn đựơc lựa chọn và vị trí của những điểm neo khác không 

thay đổi. 

5. Chọn một trong những điểm neo đơn lẻ tren Path và kéo nó tới một vị trí mới. Chú ý tới những thay 

đổi của nó tới một phân đoạn gần kề hoăc những phân đoạn khác. 

6. Alt-click để chọn cả đoạn path. Khi cả đoạn path được chọn, tất cả những điểm neo thành màu đen. 

 

    Kéo từng điểm riêng lẻ           Alt-click để chọn toàn bộ path 

7. Kéo path để di chuyển toàn bộ path mà không làm ảnh hưởng đến hình dạng của nó 

Tạo một Path đóng 

Tạo một path đóng khác biệt với tạo một path mở ở cách mà bạn đóng path. 

1. Chọn công cụ Pen ( ) 

2. Nhấn vào điểm J để bắt đầu Path, sau đó nhấp vào điểm K và điểm L 

3. Để đóng lại path, đặt con trỏ qua điểm khởi đầu là điểm J, một vòng tròn nhỏ xuất hiện với công cụ 

Pen chỉ ra rằng Path đó sẽ đóng lại nếu bạn nhấp chuột. Đóng một Path sẽ tự động kết thúc path. Sau 

khi path đó bị đóng, con trỏ của công cụ pen sẽ lại xuất hiện một dấu x, chỉ ra rằng nếu bạn nhấp chuột 

sẽ tạo ra một path mới. 
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4. Để thực hành thêm, bạn vẽ thêm một path đóng nữa, sử dụng hình ngôi sao có sẵn 

5. Khám phá những thumbnail trong Path Palette. Tại điểm này, tất cả những path bạn vẽ xuất hiện 

trong Work Path Straight Lines ở trong Path Palette. Mỗi một path riêng lẻ trong path Straight Line 

được gọi là subpath (Path phụ) 

Tô vẽ với path 
Path và những điểm neo không phải là những thành phần sẽ được in ra của hình ảnh. Bởi vỉ những 

điểm màu đen bạn nhìn thấy trên màn hình khi bạn vẽ với công cụ Pen là path chứ không phải là nét 

vẽ nó không đại diện cho bất cứ một đơn vị Pixel của hình ảnh nào. Khi bạn bỏ chọn Path, những điểm 

neo và path sẽ bị ẩn đi. Bạn có thể làm cho path xuất hiện khi in ấn bằng cách thêm nét vẽ cho nó, 

bằng cách này bạn sẽ thêm những đơn vị pixel vào hình ảnh. Stroke sẽ tô màu dọc theo Path, Fill sẽ tô 

vùng bên trong của một path đóng bằng cách tô nó với một màu, hình ảnh hoặc Pattern. Để stroke 

hoặc fill path bạn phải chọn nó trước. 

1. Đổi màu nên trước thành màu đen 

2. Chọn công cụ Direct Selection ( ) và nhấp để chọn đường thẳng zic zac trong cửa sổ 

3. Trên menu của Path Palette, chọn Stroke Subpath để mở hộp thoại Stroke Subpath 
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4. Ở ô Tool, chọn Brush từ menu hiển lên và nhấp OK. Path của bạn đã được stroke với những thông 

số của brush hiện tại 

 

Chú ý: Bạn có thể chọn một công cụ vẽ và thiết lập thông số trước khi bạn chọn Tool trong hộp thoại 

Stroke Subpath. 

Bây giờ bạn sẽ tô cho một trong những path đã tạo 

5. Nhấp vào hình tam giác với công cụ Direct Selection. Sau đó chọn Fill Subpath từ menu Path 

Palette. Hộp thoại Fill Subpath xuất hiện 

6. Trong hộp thoại này, nhấp Ok để chấp nhận mặc định. Hình tam giác được tô với màu của nền 

trước. 

 

7. Để ẩn path, nhấp vào một vùng trống dưới tên của Path ở trên Path Palette 
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8. Chọn File > Close và không  cần lưu lại gì hết. 

Vẽ một path cong 
Path cong được tạo bởi nhấp và kéo. Lần đâu tiên bạn nhấp và kéo, bạn sẽ đặt điểm bắt đầu cho path 

cong và cũng xác định luôn hướng của đường cong. Khi bạn tiếp tục kéo, path cong sẽ được vẽ ở giữa 

điểm trước đó và điểm hiện tại. Khi bạn kéo công cụ Pen, Photoshop vẽ một đường định hướng và 

điểm định hướng từ những điểm neo. Bạn có thể sử dụng những đường định hướng và điểm định 

hướng để điều chỉnh hình dạng và hướng của đường cong. Bạn sẽ chỉnh sửa path bằng cách sử dụng 

đường định hướng và điểm định hướng sau khi bạn thực hành với path cong. 

 

Giống như path chưa được tô, đường định hướng và điểm định hướng không được in ra sau này bởi 

vì chúng là đối tượng vector mà không chứa các đơn vị Px. 

1. Sử dụng File Browser hoặc chọn File > Open để mở file Curve.psd trong thư mục Lesson9. 

2. Chọn công cụ Pen ( ) 

3. Kéo con trỏ của công cụ Pen, bắt đầu từ điểm A và dừng lại tại điểm đỏ trên đường định hướng. Khi 

bạn thả chuột, một điểm neo sẽ xuất hiện tại điểm A và hai đường định hướng sẽ mở rộng lên trên và 

xuống dưới điểm neo. 
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4. Kéo từ điểm B đến điểm đỏ nằm dưới nó 

Chú ý: Nếu bạn có sai sót gì trong khi vẽ, chọn Edit > Undo để làm lại hoặc dùng History Palette. Nếu 

bạn giữ phím Shift bạn sẽ có được một đường định hướng nghiêng một góc là 45 độ 

 

5. Để hoàn thành đường cong bằng cách kéo từ điểm C đến điểm đỏ của nó và từ điểm D đến điểm đỏ 

của nó. Kết thúc path sử dụng một trong những phương pháp đã học. Bây giờ bạn hãy tạm thời lưu lại 

Work Path để tránh bị mất nội dung của nó. 

6. Nhấp đúp vào Work Path trong Path Palette để mở hộp thoại Save Path. Trong ô name điền Curve 1 

và nhấn OK. 

Tạo những Work Path độc lập 
Khi bạn vẽ những phân đoạn thẳng ở đầu bài học này, bạn đã vẽ một đường thẳng đứng, một đường 

nghiêng, một đường zic zac, và một hình tam giác. Tất cả những đường này là Subpath của Work Path 

Straight Lines trong Path Palette. Đôi lúc bạn muốn phân chia những line khác nhau khi bạn vẽ với một 

path hoàn thiện, do đó bạn có thể chỉ định những tính năng thêm vào mức độ của Path. Để bắt đầu 

một Work Path mới, bỏ chọn path hiện tại trên path Palette và bắt đầu vẽ. 

1. Trong Path Palette, nhấp chuột chọn một vùng trống dưới Curve 1 để bỏ chọn Path. 

www.vietphotoshop.com  - Dịch bởi Bá tước Monte Cristo 



Chương 9 - Cơ bản về công cụ Pen                                                                           Photoshop CS 

Chú ý: Khi bạn bỏ chọn một path trogn Path Palette, tất cả path hoặc subpath trong nó đều bị bỏ chọn. 

Nó sẽ ẩn đi bởi vì path không mang các đơn vị pixel trong nó. 

2. Kéo lên từ điểm E cho đên điểm màu đỏ, Khi bạn thả chuột từ điểm E một đường Work Path mới sẽ 

xuất hiện trên Path Palette. 

3. Kéo từ điểm F lên điểm đó. 

 

4. Kết thúc path bằng những cách đã học. 

5. Nhấp đúp vào Work Path trong Path Palette để mở hộp thoại Save Path, chõ Curve 2 để đặt tên cho 

nó và nhấp OK 

6. Trong Path Palettee, nhấp vào một vùng trống dưới Curve 2 để bỏ chọn nó. 

 

Vẽ một path cong đóng 

Bây giờ bạn sẽ vẽ một đường tròn, sử dụng những phương pháp học được từ việc vẽ đường cong. 

1. Kéo từ điểm G lên đến điểm màu đỏ, sau đó kéo xuống từ điểm H đến điểm màu đỏ. 

2. Đóng Path lại bằng cách đặt con trỏ qua điểm G và nhấp chuột. 
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3. Trên Path Palette, nhấp đúp vào Work Path và gõ chữ Closed path để đặt tên cho nó, sau đó nhấp 

vào một khoảng trống để bỏ chọn 

Sửa chữa Path cong 

Bây giờ bạn sẽ sửa chững đường cong mà bạn vừa vẽ 

1. Chọn Direct Selection ( ).  

Để chọn công cụ Direct Selection bằng lệnh gõ tắt nhấn phím A. Hơn nữa, khi công cụ Pen đang 

được chọn bạn có thể tạm thời chuyển qua công cụ Direct Selection bằng cách giữ phím Ctrl. 

2. Trong Path Palette, nhấp vào Curve 2 để chọn nó, sau đó nhấp vào path trên cửa sổ chính để chọn 

nó 

3. Nhấp vào điểm E và kéo một trong những điểm định hướng của nó theo hướng nào tuỳ bạn để thay 

đổi độ dài, độ dốc hoặc cả hai hướng cho đường định hướng đó. 

Chú ý rắng độ dốc của những đường định hướng khác của điểm đó cũng thay đổi cho nên nó luôn luôn 

là một đường 180 độ từ điểm mà bạn đang kéo.  

 

4. Bây giờ kéo điểm neo E để thay đổi vị trí của đường cong 
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5. Thử kéo phân đoạn đó và chú ý những gì xảy ra cho đường định hướng và các điểm neo. 

Stroke và Fill path 

Ở phần trên của bài học này, bạn đã sử dụng lệnh Stroke ở Path Palette để thêm màu cho đường 

path. Bạn có thể Stroke hoặc Fill path bằng cách kéo tên của path vào một nút đặc biệt ở dưới cùng 

của Path Palette. Để thiết lập những tuỳ chọn mà bạn sẽ áp dụng cho path, bạn sẽ chọn một công cụ 

vẽ và những tuỳ biến của nó trước khi bạn kéo path vào nút đặc biệt này trên Path Palette. 

Chú ý: Những nút trong Path Palette áp dụng những nét vẽ trên toàn bộ subpath liên quan đến nó trên 

cùng một path. Để áp dụng nét vẽ chỉ cho vài subpath, sử dụng lẹnh Stroke thay thế. 

1. Chọn công cụ Brush ( ) 

2. Kéo path Curve 1 vào nút Stroke Path With Brush ( ) ở dưới cùng của Path Palette để stroke path 

với thông số của brush. Chú ý rằng tác vụ này không chọn Curve 1 Path, Curve 2 path vẫn được chọn 

trên path Palette. 

 

Nếu bạn muốn thêm lệnh Fill hoặc Stroke vào Path đã được lựa chọn trong Path Palette, bạn 

không cần phải kéo nó vào nút kia trong Path Palette bạn chỉ cần nhấp vào nút đó nếu bạn muốn áp 

dụng.  
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3. Trong Path Palette, kéo Closed path vào nút Fill Path With Foreground Color ( ) ở dưới cùng của 

Path Palette để tô nó với màu nền trước. Khi bạn tô một path mở, Photoshop sẽ tự động vẽ một đường 

thẳng không nhìn thấy được nối điểm điểm đầu và điểm cuối, và tô cho những khoanh vùng nằm giữa 

nó 

4. Đặt màu nền trước là màu khác, bạn tuỳ chọn. 

5. Trong Path Palette, kéo Curve 1 vào nút Fill Path With Foreground Color. 

6. Chọn File > Close và không cần lưu lại. 

Kết hợp những phân vùng path cong và thẳng 

Bạn đã học được cách vẽ đường cong và đường thẳng riêng biệt, bây giờ bạn sẽ kết hợp nó lại để tạo 

ra những góc tròn và những đường cong mềm mại. Những điểm neo Smooth có những đường định 

hướng hoàn toàn khác biệt nhau. Conner point thì không có nhiều đường định hướng mà chỉ có một 

hoặc hai có độ lơn của góc là 180 độ.  

Kết hợp hai phần vùng cong tại một góc nhọn 

Một trong những sự kết hợp khó khăn nhất là kết hợp hai path cong nhập vào nhau ở một góc. Bạn sẽ 

thực hành với nó ngay bây giờ để biết tôi nói là không sai.  

1. Sử dụng File Browser hoặc chọn File > Open để mở file Combo.psd trong thư mục Lesson9. 

2. Chọn công cụ Pen 

3. Kéo từ điểm A lên điểm màu đỏ, và sau đó kéo từ điểm B xuống điểm màu đỏ ở dưới nó. Tại điểm 

B, bạn phải tạo một điểm Conner để thay đổi hướng của đường cong tiếp theo. 

4. Alt-click vào điểm B để thiết lập Conner Point. Chú ý rằng con trỏ bao gồm một mũi tên nhỏ khi bạn 

giữ phím Alt xuống. 
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5. Giữ phím Alt xuống lần nữa, kéo từ điểm B đến điểm màu đỏ, để thêm vào đường định hướng. 

Đường mới sẽ tác động tới hướng của đường cong mà bạn sẽ vẽ tiếp theo, khi bạn thêm một điểm 

neo khác. 

 

6. Kéo xuống từ điểm C từ điểm màu đỏ để hoàn thiện path. Sau đó kết thúc path bằng cách bạn đã 

học. 

Kết hợp phần vùng cong với đường thẳng 

Khi bạn tạo một path mà kết hợp đường thẳng và đường cong, bạn tạo một conner point để chỉ ra điểm 

chuyển đổi từ đường thẳng thành đường cong và ngược lại. Ở phần này bạn sẽ vẽ hai phân đoạn 

đường thẳng riêng biệt, tạo hai hình cong riêng biệt: một hình bán nguyện và một hình chữ S. Vị trí của 

đường định hướng cho conner point xác định loại đường cong nào sẽ được tạo. 

1. Để bắt đầu vẽ Path thứ 2 (đầu tiên là đường thẳng), nhấp vào điểm D với công cụ Pen, và giữ phím 

Shift và click vào điểm E (đừng kéo). 

2. Di chuyển con trỏ qua điểm E và kéo đến điểm màu đỏ để thiết lập đường định hướng cho phân 

đoạn sau sẽ là một đường bán nguyệt hướng lên trên 

 

3. Kéo từ điểm F đến điểm màu đỏ và giữ Alt-click vào điểm F để tạo Conner point 
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4. Giữ phím Shift và nhấp vào điểm G để tạo một đường thẳng. Sau đó kết thúc path lại 

5. Nhấp vào điểm H bằng công cụ Pen để bắt đầu một path mới cho đường cong chữ S và giữ phím 

Shift và click vào điểm I 

6. Tại điểm I, Alt-kéo từ điểm I đến điểm màu đỏ để tạo cho điểm I một conner point. 

 

7. Kéo điểm J xuống điểm màu đỏ. 

 

8. Alt-click vào điểm J để biến nó thành conner point. 

www.vietphotoshop.com  - Dịch bởi Bá tước Monte Cristo 



Chương 9 - Cơ bản về công cụ Pen                                                                           Photoshop CS 

 

9. Shift-click vào điểm K và sau đó đóng path lại với những cách bạn đã học 

10. Chọn File > Close 

Chỉnh sửa những điểm neo 
Một trong những điểm thuận lợi khi vẽ bằng công cụ Pen là bạn có thể quay lại và thay đổi đưòng path 

bạn vẽ. Bạn đã học cách di chuyển điểm neo, phân đoạn, và các đường định hướng. Trong phần này, 

bạn sẽ thấy việc thêm một điểm neo vào một path có sẵn đễ dàng như thế nào, xoá điểm neo, và biến 

đổi những điểm neo từ một dạng này sang dạng khác. 

Thêm và bớt điểm neo 

Bạn có thể thêm điểm neo vào một path để gia tăng số phân vùng của path đó và bạn có thể bớt 

những điểm neo không cần thiết trên path. 

1. Sử dụng File Browser hoặc chọn File > Open để mở file Edit.psd trong thư mục Lesson9. Hai path 

đã được đặt tên và lưu lại trong path Palette. Bạn sẽ chỉnh sửa path bằng cách sử dụng công cụ Pen 

và công cụ Convert Point. 

2. Trong Path Palette, nhấp vào path ở trên (có tên là Add and delete points) để chọn nó. Hai subpath 

sẽ xuất hiện trong cửa sổ chính. 

3. Chọn cộng cụ Add-anchor point ( ) được nằm ẩn dưới công cụ Pen. Sau đó định vị con trỏ qua 

điểm đỏ ở trung tâm của đường thẳng và nhấp chuột. Một điểm neo với đường định huớng sẽ được 

thêm vào phân vùng, và con trỏ xuất hiện là một mũi tên rỗng ( ) do đó bạn có thể chọn và sửa đổi 

path. 

4. Bây giờ chọn và kéo path quay lên trên. Tiếp đến bạn sẽ bỏ đi những điểm neo trên path. 
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5. Chọn công cụ Direct Selection ( ) và chọn Path thứ 2 

Chú ý: Bạn phải chọn path trước khi bạn có thể xoá điển neo của nó. Tuy nhiên bạn có thể chọn pth và 

điểm neo mà không cần phải chọn công cụ. Nếu path được chọn, chỉ việc di chuyển công cụ Pen qua 

một phân đoạn để thay đổi nó thành công cụ add-anchor-point 

6. Chọn công cụ delete-anchor-point ( ) ẩn đưới công cụ Add-anchor-point ( ), đặt con trỏ trên chấm 

đỏ qua tâm của điểm neo, và nhấp vào nó để xoá điểm neo. 

 

Biến đổi điểm neo 

Đôi khi bạn có thể muốn thay đổi đường cong thành một conner point và ngược lại. Sử dụng công cụ 

Convert Point sẽ dễ dàng giúp bạn được điều này. Sử dụng công cụ Convert Point gần giống như vẽ 

bằng công cụ Pen. Để biến một đường cong thành một conner point, bạn nhấp chuột vào điểm neo đó, 

và để biến một conner point thành đường cong, bạn kéo từ điểm neo đó. 

1. Trong Path Palette, chọn Convert Direction path. Hình dạng path có bốn conner points và các đường 

cong. Bạn sẽ bắt đầu với việc biến những conner poin thành đường cong, và sau đó bạn sẽ biến 

đường cong thành conner point. 

2. Sử dụng công cụ Direct Selection ( ), chọn vùng ngoài của subpath 

3. Chọn công cụ Convert Point ( ) được ẩn dưới công cụ delete-anchor-point tool ( ) 

4. Đặt con trỏ lên một điểm của path bên ngoài, và nhấp và kéo theo chiều kim đồng hồ để biến điểm 

neo từ conner point thành đường cong. 
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5. Biến những điểm còn lại thành Smooth point để hoàn thành đường bên ngoài. 

 

6. Sử dụng công cụ Convert Point ( ), nhấp vào vùng tỏng của subpath để chọn nó và sau đó nhấp 

vào điểm neo ở trên đỉnh của mỗi đường cong để biến nó thành điểm uốn. Bạn cũng có thể sử dụng 

công cụ Convert Point để điều chỉnh một bên của một phân vùng cong. Bạn sẽ thử cách này ở vùng 

ngoài của path 
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7. Nhấp vào vùng ngoài của path với công cụ Direct Selection ( ), sau đó nhấp vào một phân vùng 

cong sao cho đường định hướng và điểm định hướng xuất phát từ một điểm neo. 

 

8. Chọn lại công cụ Convert Point ( ), kéo một trong những điểm định hướng để thay đổi hình dạng 

của một cạnh của đường cong. 
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9. Đóng tài liệu lại mà không cần lưu gì hết. 

Sử dụng Path với hình ảnh 

Bạn đã thực tập một số với những hình có sẵn, bạn sẽ sử dụng công cụ Pen để tạo vùng lựa chọn cho 

chiếc đĩa bay sau. Chiếc đĩa bay có đường viền rất dài, cong và mềm mại. Nó sẽ rất khó nếu bạn dùng 

phương pháp khác để tạo vùng lựa chọn. Bạn sẽ vẽ một đường Path xunh quanh tấm hình và tạo hai 

đường khác ở trong tấm hình. Sau khi bạn vẽ xong đường Path, bạn sẽ biến chúng thành vùng lựa 

chọn. Tiếp theo bạn sẽ bớt vùng lựa chọn của hình này từ hình khác sao cho mỗi chiếc đĩa bay được 

chọn và không có chút nào của hình bầu trời hết. Cuối cùng bạn sẽ tạo một layer mới từ bức hình chiếc 

đĩa bay và thay đổi hình hình nền của nó.  

Khi bạn vẽ với những đường path tự do sử dụng công cụ Pen, sử dụng càng ít điểm neo càng tốt để 

tạo ra hình mà bạn muốn. Càng ít điểm neo được dùng, đường cong càng mêm mại và công việc của 

bạn càng hiệu quả. Điều cốt lõi trong bài học này là bạn sẽ sử dụng công cụ Pen để nối những chấm 

từ điểm A đến điểm N và quay lại điểm A, hãy thực hành với những gì bạn học ở chương này để tạo ra 

những loại điểm neo khác nhau. 
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       Cách làm đúng                   Có quá nhiều điểm neo 

• Bạn sẽ thành lập những phân đoạn thẳng chỉ đơn giản bằng cách nhấp chuột tại điểm C, F, J 

và M 
• Bạn sẽ tạo đường uốn mềm bằng cách kéo điểm màu đỏ cho các điểm A, D, E, G, H, I, K và J 

Bạn sẽ đặt một điểm uốn cho quá trình chuyển đổi từ đường cong thành một phân đoạn thẳng (tại 

điểm B) bằng cách trước tiên tạo một điểm Smooth Curve - lần nữa, bằng cách kéo điểm màu đỏ - và 

sau đó loại bỏ một trong những đường định hướng bằng cách nhấn Alt-Click 

• Bạn sẽ thiết lập một điểm uốn cho quá trình chuyển đổi từ phân đoạn thẳng thành một đường 

cong bằng cách đầu tiên nhấn nhưng không kéo để tạo ra một điểm uốn và sau đó giữ phím 

Alt và kéo điểm neo N. 
• Nếu bạn đã sẵn sàng để thực hành, bạn có thể tập làm bài này sử dụng những lời chỉ dẫn ở 

trên. Hoặc theo những bước sau trước để đảm bảo bạn đi đúng hướng. 

Vẽ path theo hình bằng Pentool 
Sử dụng những bước sau để tạo đương Path, đường phác thảo của hình chiếc tầu vũ trụ 

1. Sử dụng File Browser hoặc chọn File > Open để mở file Saucer.psd trong thư mục Lesson9 

2. Chọn công cụ Pen. 

3. Đặt con trỏ ở điểm A và kéo đến điểm màu đỏ để thiết lập một điểm neo và định hướng cho đường 

cong đầu tiên. Sau đó làm tương tự với điểm B. Tại góc của buồng lái (điểm B), bạn sẽ cần phải tạo 

một điểm uốn, để tạo một vùng chuyển giao giữa phân vùng cong và thẳng.  
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4. Alt-click điểm B để chuyển Smooth Point thành điểm uốn bằng cách loại bỏ một trong những đường 

định hướng. 

 

              Thiết lập Smooth point tại B          Biến đổi Smooth point thành điểm uốn 

5. Nhấn vào điểm C để lập một phân vùng thẳng (đừng kéo) 

6. Kéo lên điểm D từ điểm màu đỏ. Sau đó kéo xuống từ điểm E đến điểm màu đỏ của nó 

7. Nhấp vào điểm F 

8. Thiết lập điểm uốn ở G, H và I bằng cách kéo từng cái một đến những điểm màu đỏ tương ứng. 

9. Nhấp vào điểm J 

10. Thiết lập điểm uốn tại K và L bằng cách kéo từng cái một đến những điểm màu đỏ tương ứng. 

11. Nhấp vào điểm M và sau đó là N 

12. Giữ phím Alt và kéo từ điểm N đến điểm màu đỏ, để thêm một đường định hướng vào điểm neo tại 

N 

13. Di chuyển con trỏ qua điểm A sao cho một vòng tròn nhỏ xuất hiện ở con trỏ, và nhấp để đóng 

đường Path lại. (vòng tròn nhỏ có thể khó nhìn vì hình này tối màu cho nên nó lẫn vào nền). 
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14. Trong Path Palette, nhấp đúp vào Work Path, gõ chữ Saucer vào hộp đặt tên và sau đó nhấn OK 

để lưu nó lại. 

15. Đóng tìa liệu lại nếu bạn muốn lưu thì chọn Save. 

Biến một vùng lựa chọn thành Path 

Bạn sẽ tạo một đường Path thứ hai nhưng sử dụng phương pháp khác. Trước tiên bạn sẽ dùng công 

cụ lựa chọn để chọn những vùng màu tương đồng, sau đó bạn sẽ biến vùng lựa chọn thành đường 

Path. Bạn có thể biến bất cứ vùng lựa chọn nào được tạo bởi bất kỳ công cụ lựa chọn nào thành 

đường Path. 

1. Nhấp chuột chọn thẻ Layer Palette để hiện thị nó, sau đó kéo layer Template xuống biểu tượng 

thùng rác ở dưới cùng của layer palette. Bạn không cần đến nó nữa hay nói cách khác là nó hết giá trị 

lợi dụng! ka ka ka! 

 

2. Chọn công cụ Magic Wand ( ) 

3. Ở thanh tuỳ biến công cụ của Magic Wand, điền vào giá trị là 32 

4. Hãy cẩn thận nhấp vào vùng màu đen bên trong cánh thăng bằng của đĩa bay. 

5. Shift-Click ở trong cánh thăng bằng còn lại để tạo vùng lựa chọn cho vùng màu đen đó. 
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6. Nhấp vào thẻ Path Palette để hiển thị nó. Sau đó nhấp vào nút Make Work Path From Selection (

). Vùng lựa chọn sẽ được chuyển thành Path, và một Work Path mới được tạo. 

 

Chú ý: Nếu cần bạn có thể điều chỉnh những điểm neo của đường Path, sử dụng công vụ và cách thức 

đã học. 

7. Nhấp đúp vào Work Path và đặt tên nó là Fins, nhấn OK để lưu lại 

 

8. Nếu cần thì lưu file lại. 
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Biến đổi đường Path thành vùng lựa chọn 

Cũng như khi bạn biến một vùng lựa chọn thành Path, bạn có thể biến đường Path thành vùng lựa 

chọn. Với những nét rất mềm mại, đường Path cho phép bạn tạo ra những vùng lựa chọn chính xác. 

Vừa rồi bạn đã vẽ đường Path cho con tầu vũ trụ và hai cánh cân bằng của nó, bay giờ bạn sẽ biến 

đường Path này thành vùng lựa chọn và áp dụng hiệu ứng Filter lên vùng lựa chọn này. 

1. Trong Path Palette, nhấp vào Saucer Path để chọn nó. 

2. Biến Saucer path thành vùng lựa chọn bằng những sau: 

• Ở Path Palette, chọn Make Selection và nhấn Ok để đóng hộp thoại vừa xuất hiện. 
• Kéo Saucer Path vào nút Load Path As Selection ( ) 

Sau đó bạn sẽ bớt vùng lựa chọn của cánh thăng bằng của vùng lựa chọn tàu vũ trụ để bạn có thể 

xem hình nền thay đổi thông qua vùng trong suốt của cánh thăng bằng. 

3. Trong Path Palette, nhấp chuột chọn Fins path, và trong Path Palette menu chọn Make Selection. 

 

4. Ở phần Operation của hộp thoại Make Selection, chọn Subtract from Selection và nhấn Ok 

Đường Fins path sẽ biến thành vùng lựa chọn và đồng thời bớt đí từ vùng lựa chọn của tàu vũ trụ. Cứ 

để đường path được chọn bởi vì bạn sẽ sử dụng vùng lựa chọn cho bước kế tiếp: 

Thêm layer để hoàn thành bài tâp 

Bước này chỉ chỉ cho bạn thấy dùng công cụ Pen để tạo vùng lựa chọn sẽ giúp bạn đặt được những 

hiệu ứng hấp dẫn cho hình ảnh như thế nào. Bởi vị bạn đã tách được con thuỳên, bạn sẽ tạo một bản 

copy của vùng lựa chọn trên một layer mới. Sau đó, khi bạn thêm một đối tượng vào layer nằm giữa 

layer gốc và layer copy, đối tượng đó sẽ xuất hiện ở giữa đĩa bay và nền trời sao. 

1. Trên Layer Palette, chọn layer Background do đó bạn có thể nhìn thấy vùng lựa chọn ở cửa sổ 

chính. Nếu bạn bỏ chọn nó, bạn phải lặp lại bước trước để chọn. 
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2. Chọn Layer > New > Layer Via Copy 

Một layer mới xuất hiện ở Layer Palette có tên là Layer 1. Ở hình nhỏ trên layer palette bạn chỉ thấy 

hình chiếc tàu vũ trụ mà không có bầu trơi sao vì bạn đã tách nó và dùng vùng lựa chọn để tạo layer 

mới. 

3. Trong layer palette, nhấp đúp vào layer 1 và gõ chữ Saucer để đặt tên lại cho nó 

 

4. Lưu file dưới về máy và mở nó ra trong Photoshop 
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5. Trong hộp công cụ chọn công cụ Move và kéo hình hành tinh sang cửa sổ Saucer.psd. 

 

6. Đóng file hành tinh lại và chỉ để lại file tàu vũ trụ. Hành tinh sẽ xuất hiện đằng trước hình đĩa bay. 

Bây giờ bạn phải chuyển hình chiếc đĩa bay xuất hiện lên trên hành tinh. 

7. Trong Layer Palette, kéo hình hành tinh nắm giữa layer đĩa bay và layer background. 

8. Vẫn sử dụng công cụ Move, kéo hình hành tin để thay đổi vị trí cua nó cho đến khi bạn hài lòng với 

vị trí mới. 

10. Chọn File > Save ... 

Bạn đã hoàn thành bài học với công cụ Pen. Bạn hãy thực hành thêm bằng cách vẽ đường path xung 

quanh đối tượng bằng công cụ Pen. Khi bạn đã sử dụng công cụ Pen thành thạo, bạn sẽ thấy rằng 

Pen rất tốt khi dùng để tách những hình phức tạp. 
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Câu hỏi ôn tập 

1. Bạn làm thế nào để chỉnh sửa những phân vùng đơn lẻ của đường Path? 

2. Bạn làm thế nào để chọn được toàn bộ đường Path? 

3. Bạn thêm điểm neo như thế nào? 

4. Bạn làm cách gì để xoa những điểm neo trên đường Path 

5. Khi bạn kéo vối công cụ Pen để tạo đường cong, đường cong sẽ bị tác động như thế nào bởi hướng 

mà bạn kéo? 

Đáp án: 

1. Để sửa chữa từng phân vùng đơn lẻ của đường Path, bạn kéo những điểm neo trên đường Path sử 

dụng công cụ Direct Selection. Bạn cũng có thể chỉnh sửa hình dạng của phân vùng cong đó bằng 

cách kéo điểm định hướng tại điểm cuối của đường định hướng mà được mở rọng ra ở điểm neo của 

đường cong.  

2. Để chọn toàn bộ đường Path, giữ phím Alt và nhấp vào đường Path sử dụng công cụ Direct 

Selection. Khi toàn bộ đường path được chọn, tất cả những điểm neo thành màu đen 

3. Để thêm điểm neo vào đường Path, bạn chọn côgn cụ add-anchor-point được ẩn dưới công cụ Pen 

và sau đó thì nhấp vào đường Path nơi mà bạn muốn thêm điểm neo. 

4. Để xoa điểm neo từ đường Path, bạn chọn công cụ delete-anchor-point được ẩn dưới công cụ Pen 

và sau đó nhấp vào điểm neo mà bạn muốn loại bỏ. 

5. Hướng mà bạn kéo với công cụ Pen xác định hướng của đường cong mà nó sẽ theo. 

6. Nếu bạn muốn tạo một vùng lựa chọn phức tạp, thì sử dụng công cụ Pen để vẽ sẽ dễ dàng hơn và 

sau đó dùng lệnh chuyển Path thành vùng lựa chọn. 
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